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Copyright 

Copyright © 2010 CAXperts GmbH. All Rights Reserved. 

Including software, file formats, and audiovisual displays; may be used pursuant to applicable software license agree-

ment; contains confidential and proprietary information of CAXperts and/or third parties which is protected by copy-

right law, trade secret law, and international treaty, and may not be provided or otherwise made available without 

proper authorization.  

Restricted Rights Legend  

Rights reserved under the copyright laws of the Federal Republic of Germany.  

Warranties and Liabilities  

All warranties given by CAXperts about equipment or software are set forth in your purchase contract, and nothing 

stated in, or implied by, this document or its contents shall be considered or deemed a modification or amendment of 

such warranties. CAXperts believes the information in this publication is accurate as of its publication date.  

The information and the software discussed in this document are subject to change without notice and are subject to 

applicable technical product descriptions. CAXperts is not responsible for any error that may appear in this docu-

ment.  

The software discussed in this document is furnished under a license and may be used or copied only in accordance 

with the terms of this license. THE USER OF THE SOFTWARE IS EXPECTED TO MAKE THE FINAL EVALU-

ATION AS TO THE USEFULNESS OF THE SOFTWARE IN HIS OWN ENVIRONMENT.  

Trademarks 

CAXperts is a registered trademark of CAXperts GmbH. Intergraph, the Intergraph logo, SmartSketch, FrameWorks, 

SmartPlant, INtools, MARIAN, PDS, IGDS, RIS and IntelliShip are registered trademarks of Intergraph Corporation. 

IGDS file formats ©1987-1994 Intergraph Corporation.  Microsoft and Windows are registered trademarks of Mi-

crosoft Corporation. Bentley, the Bentley logo “B,” and MicroStation are registered trademarks of Bentley Systems, 

Inc. ISOGEN is a registered trademark of Alias Limited. Other brands and product names are trademarks of their re-

spective owners. 
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1 Introduction 
ReviewManager is an easy-to-use add-on for Intergraph SmartPlant Review that en-

hances the plant design review process. It supports graphical reviewing, and data report-

ing from both PDS and SmartPlant 3D. 

1.1 General conventions 
This document contains many visual cues to help you understand the meaning of certain 

words or phrases. The use of different fonts for different types of information allows 

you to scan the document for key concepts or commands. Symbols help abbreviate and 

identify commonly used words, phrases, or groups of related information 

Typefaces 
Italic Indicates a system response, which is an explanation of what the 

software is doing. For example,  

 

The text is placed in the viewing plane. 

 

Bold Indicates a command name, parameter name, or dialog box title. 

Command paths are shown using an arrow between command 

names. For example, 

 

Choose File → Open to load a new file. 

 

Sans serif Indicates a system prompt or message, which requires an action be 

taken by the user. For example,  

 

Select first segment of alignment 

 
Normal typewriter 

 
Indicates an actual file or directory name. For example,  

 

The ASCII report is stored in the layout.rpt file. 

 
Bold typewriter 

 
Indicates what you literally type in. For example,  

 

Key in original.dat to load the ASCII file. 

 

Symbols 
This document uses the following symbols to identify special information: 

 Note – important supplemental information. 

 Map or path – shows you how to get to a specific command or form. 

 More information – indicates there is additional or related information. 
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2 Installation 

2.1 Setup 
Requirements: 

 Operating system: Windows 2000 SP4/XP/2003/2008/Vista/7 

 Intergraph SmartPlant Review, Version 2008 or later 

 Microsoft Excel 2003 or later (for Reporting) 

 Microsoft .NET Framework 2.0 

Administrator rights are required on each computer to install ReviewManager.  

2.2 License 
Once the setup has been completed and the program is started, a license key will be re-

quested as shown below. 

 

CAXperts will need your Current domain name to issue a license file (.lic). 

Please place this license file into the folder where Path to license files points to, then 

press Reload. 

You can also set the Path to license files to a different folder (e.g. a shared folder on a 

file server) using Select path. 

 Note: Without a valid license file the software will run in demo mode. 
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3 Design Review Sessions 
ReviewManager works with Design Review Sessions created directly by PDS and 

SmartPlant 3D, as well as sessions created via CAXperts PDS ReviewExtractor and 

CAXperts 3D ReviewExtractor.  

Some specialty features (such as line-tracking and automatic isometric file integration) 

are only available when using sessions created by CAXperts PDS ReviewExtractor or 

CAXperts 3D ReviewExtractor. 
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4 Review data with SmartPlant Review 

4.1 A brief overview 
The ReviewManager window is separated into several sections as follows:  

 

 Note: All sections can be resized and their visibility can be toggled. To show or 

hide a single section use the appropriate buttons ( ). Resizing can be accom-

plished by clikcing and dragging the bars between the sections ( ) and/or by resizing 

the window. 

Elements 
As can be seen on the above screenshot, ReviewManager consists of four main parts. 

Each component performs its own specific function in order to give the best control 

over ReviewManager. The following sections describe the each part and function brief-

ly. 

Tree filter (or project tree) 
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The tree filter is a visualisation of the data contained in the open SmartPlant 3D or 

PDS Review Session. Each node listed in the tree filter represents a task, attribute or 

value in SmartPlant 3D or PDS.  

As seen in the above figure, the base nodes are always task nodes, and can be added, or 

removed with the AttributeManager (Tools → AttributeManager). Task nodes cannot 

be renamed. 

The second node type visible are the attribute nodes. These nodes can be differentiated 

from the value nodes by bold text and from the task nodes by position. The last type of 

node seen in the above figure is a value node type. These represent the existing values 

for an attribute. 

Display Set tab 
The display set tab manages the available display sets. New display sets can be easily 

created via a context menu (right click) on the items in the tree filter.  

 

There are three classifications of display sets defined in ReviewManager. The Normal 

display sets header contains all of the display sets that were created via the context 

menu item Add to display set.  

Operations such as renaming, highlighting, setting the colour of the display set contents, 

etc. can be performed via a right mouse context menu. 

  

The Hidden display sets node stores those display sets which were marked as hidden 

via the context menu item "Hide" on the items in the tree filter.  

The Transparent display sets node stores those objects which were marked as trans-

parent via context menu item "Transparent" on the items in the tree filter.  

Display sets can be removed via the Delete context menu item. 
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Attributes 
The attributes panel lists the attributes of a selected object in the tree filter. Checking 

or un-checking an attribute adds or removes the corresponding column in the data grid. 

Data grid 
The data grid displays the data that is selected in the project tree and attributes panel. 

All columns shown are based on selections made in the attributes panel. 

The data grid may contain two types of columns: 

▪ Path columns are shown in italics and reflect the path attribute selected. If they 

have a value selected in the project tree, the column will not be filterable. 

▪ Attribute columns reflect all other attributes selected in the attribute panel. 

4.2 Review project 

Tree hierarchy 
After loading a Design Review Session (SmartPlant Review Files (*.dri, *.vue)), the 

tasks / disciplines and attributes will be displayed in the tree view. For reviewing along-

side SmartPlant Review, it is better to turn off the attribute panel and the data grid panel.  

 

The project tree (or tree filter) can be used to filter attributes and values. For this pur-

pose the desired attribute nodes may be nested. Select Add attributes/Remove attrib-

utes from the appropriate task or attribute node's context menu (right click) to achieve 

your desired tree hierarchy. For example, if you wish to know which pipe lines are in a 

particular unit system, you can right mouse click on the attribute “Unit System” to add 

the attribute “Pipeline System” below the main node: 
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This process can be repeated recursively until the desired granularity has been reached. 

Context menu 
A click with the right mouse button on any item in the tree view opens the context 

menu: 

 

The context menu provides (depending on the item selected) numerous functions: 

 Configure the tree filter (Add attributes, Add all attributes) 

 Fit the selected item to the main view of SmartPlant Review (Fit) 

 Highlight the selected item in SmartPlant Review (Highlight) 

 Move the selected item to the centre of the main view (Move to centre) 

 Hide or make the selected item transparent (Hide, Transparent) 
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 Show only the selected item (Show only). Context menu Clear show on-

ly/Volume clipping will be available after Show only. 

 Show the selected item and its environment with an offset (Volume clip-

ping…) 

 

Using the up or down button will increase or decrease the offset. If Inside 

only is checked, only the objects fully inside the volume will be shown. 

Otherwise, objects overlap with the volume will also be shown. 

 A display set can be created using one click of a right mouse context 

menu (Add to display set). One display set will be created automatically 

in SmartPlant Review, and the created display set will also be added to 

the display set tab automatically, where you can rename and manipulate 

the display. 

 By right mouse clicking on a PDS “line_id” or on a SmartPlant 3D “Pipe-

line System”, available isometric files will be shown (Iso files). This 

functionality is reserved solely for sessions created from CAXperts PDS 

ReviewExtractor (for Intergraph PDS) or CAXperts 3D ReviewExtrac-

tor (for Intergraph SmartPlant 3D). The iso files can be opened by click-

ing on the filename via the context menu. 

 For the same item as describe above of “Iso Files”, one can track line on 

an item of PDS “line_id” or an item of SmartPlant 3D “Pipeline System” 

(Track line in SmartPlant Review). This feature works only with the 

sessions created from CAXperts PDS ReviewExtractor or CAXperts 3D 

ReviewExtractor. 

 

The user may select a component, use previous ( ), next ( ), restart (

), play ( ) and stop ( ) buttons and choose a step interval. 

 

 Any type of file can be linked (Add documents) to a node in the tree 

view. Captions of nodes with links attached become blue coloured. 

Linked documents can be reviewed or removed via the context menu. 

Documents can also be linked via an Excel list using Tools → Add doc-

uments from Excel. The input Excel file should have the following for-

mat with four columns in the first Excel sheet. The first column is the 

task or discipline name. The second and third columns are attribute name 

and attribute value, where the documents should be linked to. The fourth 

column is for the path input of the document to be linked. 
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Results: 

 

 

ReviewManager navigation toolbar 
ReviewManager features a floating toolbar that allows a quick navigation on top of 

SmartPlant Review. 

 

 Pan & fit ( ) – Move the viewpoint along the model. Use the 

slider on the left hand side to change the step size of each move. Click the 

button in the middle ( ) to fit the whole model into the view. 

 Zoom in/out ( ) - Use the slider to change the step size. 

 Undo/redo ( ) – Undo/redo view operations. 



Review data with SmartPlant Review 

    13 

 Create PDF report ( ) – Generate a sheet with screenshots of the cur-

rent view and the three main views 

 Load/save ReviewManager session ( ) – Save the current state or 

scenario as ReviewManager session or load a ReviewManager session.  

 Show object attributes ( ) – Show the attributes of the object that has 

been selected. Click this button, select an object with a left click or abort 

with right click. Afterwards a box like the following will be shown listing 

the object attributes. One can use the option Show attribute manager at-

tributes to have a better attribute list configured from attribute manager. 

 

 Transparent view mode ( ) – Make all objects transparent, except for 

those in the created display sets in ReviewManager. 

 Refresh view( ) 

 Show or hide the tree view/report window  ( / ) 

 View control ( ) – Change the common view on your project. 

4.3 Reporting 
For the currently selected node in the tree filter (of the left panel), the related data will be 

shown in the grid view as shown below: 
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The columns displayed in the data grid can be configured by checking/unchecking the at-

tributes in the middle attribute panel. 

Within the data grid, columns can be sorted, moved, filtered or resized. Click on the Cus-

tom sort  icon to sort the grid. To reorder the columns, grab and drag the column you 

want to move and drop it to its new location. Click on the field under the column name in 

the data grid and select a value in the dropdown box to make a filter. Drag the space be-

tween columns to the right in order to increase the width of a column, and to the left in order 

to decrease the width of the column. 

Export to Microsoft Excel 
To export a report into a spread sheet select Export to Excel…. The following dialog will 

appear. 

 

When Use a template is checked the selected file will be used to format the data. It is rec-

ommended to create a template using the New button. This will invoke an Excel macro 

which helps to create and customize a template. 
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The macro offers the following options/settings: 

 Create standard report – apply the Header and Skip Lines setting and 

rebuild the sheet 

 Add column – insert a column wildcard in the cell currently selected 

 Header lines – insert the number of rows that should be between the up-

per border and the column wildcards 

 Skip lines between rows – insert the given number of rows between each 

line with data 

Additionally you are able to insert pictures, i.e. your company logo, as well as further text 

and formatting. 

Close and save the template when you have finished. The Create Report dialog will be dis-

played again. Hit Create Report to generate the report. 
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ReviewManager contains only basic reporting functionality. For further reporting function-

ality, including aggregate function (sum, max, min etc.), creating reports across multiple ap-

plications (e.g. produce a line list with associated data from SmartPlant® P&ID, 3D and 

Materials), as well as to check, validate and combine data between applications, please use 

CAXperts UniversalReporter. 
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5 Technical support 
Need further assistance? Contact CAXperts support online, by email, or by phone: 

mailto:support@caxperts.com 

http://www.caxperts.com/component/option,com_contact 

 

mailto:support@caxperts.com
http://www.caxperts.com/component/option,com_contact

